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NEW QUESTION 1

Refer to the exhibit. In an active SIP call between phone user A and phone user B, phone A initiates a call transfer to phone user C. Which two scenarios are
correct? (Choose two.)

A. Phone_A sends a SIP-REFER message to the Cisco Unified Communications Manager with Phone_C information in the Refer-To section.
B. Phone_B sends a SIP-REFER message to the Cisco Unified CM with Phone_C information in the Refer-To section.
C. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_B User Hold MOH
Audio Source settings.
D. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the music on hold and the MOH audio is chosen from Phone_A Network
Hold MOH Audio Source settings.
E. As soon as Phone_A presses the Transfer button for the first time, Phone_B hears the MOH and the MOH audio is chosen from Phone_A User Hold MOH
Audio Source settings.

Answer: AC

NEW QUESTION 2
The administrator of ABC company is troubleshooting a one-way audio issue for a call that uses H.323 protocol (slow-start mode). The administrator requests that
you provide the IP and port information of the Real-Time Transport Protocol traffic that had the one-way audio call.
You gather the H.225 and H.245 messages for one of the one-way audio calls. Where can you find the RTP IP and port information for both sides? (Note: This call
flow has not invoked any media resources like MTP or transcoders).

A. H.245 Terminal Capability Set
B. H.245 Open Logical Channel
C. H.225 Connect
D. H.245 Open Logical Channel Ack

Answer: B

NEW QUESTION 3
Cisco SIP IP telephony is implemented on two floors of your company. Afterward, users report intermittent voice issues in calls established between floors. All calls
are established, and sometimes they work well, but sometimes there is oneway audio or no audio. You determine that there is a firewall between the floors, and
the administrator reports that it is allowing SIP signaling and UDP ports from 20000 to 22000 bidirectionally. What are two possible solutions? (Choose two.)

A. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 16384-32767
B. Ask the firewall administrator to change the ports to TCP.
C. Ask the firewall administrator to change the range of UDP ports to 16384-32767.
D. Go to the SIP profile assigned to these IP phones in Cisco Unified CM and change the range of media ports to 20000-22000.
E. Go to System Parameters in Cisco Unified Communications Manager and change the range of media ports to 20000-22000.

Answer: AC

NEW QUESTION 4
Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?

A. Analysis Manager > Inventory > Trace File Repositories
B. System > Tools > Trace and Log Central
C. Voice/Video > Session Trace Log View > Real Time Data
D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 5
A support engineer is troubleshooting a voice network. When conducting a search for call setup details related to calling search space issues, which trace files
should be investigated?

A. CallManager traces
B. CTI Manager traces
C. Cisco IP Manager Assistant
D. Call logs

Answer: A

NEW QUESTION 6
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Refer to the exhibit. A user reports that when they call a specific phone number, no one answers the call, but when they call from a mobile phone, the call is
answered. The engineer troubleshooting the issue is expecting the far-end gateway to cut through audio on the 183 Session Progress SIP message. Which SIP
Profile configuration element is necessary for the Cisco Unified Communications Manager to send acknowledgement of provisional responses?

A. Allow Passthrough of Configured Line Device Caller Information must be enabled.
B. Accept Audio Codec Preferences in Received Offer must be set to On.
C. On the SIP Profile, the configuration parameter SIP Rel1XX Options must be set to Send PRACK for all 1xx Messages.
D. Early Offer for G Clear Calls must be enabled.

Answer: C

NEW QUESTION 7
Which action is correct with respect to toll fraud prevention configuration in the Cisco Unified Communications Manager Express?

A. Configure Direct Inward Dial for Incoming ISDN Calls with overlap dialing.
B. Configure IP Address Trusted Authentication for Incoming VoIP Calls.
C. Configure the command no ip address trusted authenticate under “voice service voip”.
D. Enable Secondary Dial tone on Analog and Digital FXO Ports.

Answer: B

NEW QUESTION 8

Refer to the exhibit. Users report that outbound PSTN calls from phones registered to Cisco Unified Communications Manager are not completing. The local
service provider in North America has a requirement to receive calls in 10-digit format. The Cisco Unified CM sends the calls to the Cisco Unified Border Element
router in a globalized E.164 format. There is an outbound dial peer on Cisco Unified Border Element configured to send the calls to the provider. The dial peer has
a voice translation profile applied in the correct direction but an incorrect voice translation rule applied, which is shown in the exhibit. Which rule modified DNIS in
the format that the provider is expecting?

A. rule 1 /^/+\([^1].*\)/ /011\1/
B. rule 1/^\+1\([2-9]..[2-9]……$\)/ /\1/
C. rule 1 /^\([2-9]..[2-9]……$\)/ /\1/
D. rule 1 /^\+1\([2-9]..[2-9]……$\)/ /\0/

Answer: B

NEW QUESTION 9

Refer to the exhibit. An administrator is troubleshooting why users are not hearing audio when dialing long distance numbers across their Cisco Unified Border
Element. The customer’s carrier has a requirement that dialing long distance requires an access code to be entered. Looking at the exhibit, what two actions can
be taken to correct signaling? (Choose two.)
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A. Enanle PRACK.
B. Enable Early Offer on the Cisco Unified Border Element.
C. Enable the supplementary-service media-renegotiate command.
D. Enable Media Flow Around
E. Enable Mid-Call Signaling Consumption.

Answer: AB

NEW QUESTION 10
Which IOS command creates a SIP- enabled dial peer?

A. voice dial-peer 20 sip
B. dial-peer voice 20 voip
C. dial-peer voice 20 pots
D. dial peer voice 20 sip

Answer: B

NEW QUESTION 10
A user in location X dials an extension at location Y. The call travels through a QoS-enabled WAN network, but the user experiences choppy or clipped audio.
What is the cause of this issue?

A. missing Call Admission Control
B. codec mismatch
C. ptime mismatch
D. phone class of service issue

Answer: B

NEW QUESTION 11
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

A. example.com@gateway.corporate.local
B. *@example.com
C. gateway.corporate.local
D. example.com
E. *.*

Answer: BE

NEW QUESTION 13
A network engineer designs a new dial plan and wants to block a certain range of numbers (8135100 through 8135105). What is the most specific route pattern
that can be configured to block only the numbers in this range?

A. 813510[012345]
B. 813510[12345]
C. 813510[^0-5]
D. 81XXXXX

Answer: A

NEW QUESTION 17
Which two descriptions of the Standard Local Route Group deployment are true? (Choose two.)

A. can be associated under the route group
B. can be associated only under the route list
C. chooses the route group that is configured under the device pool of the calling-party device
D. chooses the route group that is configured under the device pool of the called-party device
E. can be assigned directly to the route pattern

Answer: BD

NEW QUESTION 18
After configuring a Cisco CallManager Express with Cisco Unity Express, inbound calls from the PSTN SIP trunk receive a ring tone for 20 seconds and then a
busy signal instead of voicemail. Which configuration fixes this problem?

A. Router(config)# voice service voipRouter(conf-voi-serv)#allow-connections h323 to h323
B. Router(config)#dial-peer voice 2 voipRouter(config-dial-peer)#no vad
C. Router(config)# voice service voipRouter(conf-voi-serv)#allow-connections voice-mail mod
D. Router(config)# voice service voipRouter(conf-voi-serv)#no supplementary-service sip moved-temporarily

Answer: A

NEW QUESTION 21
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In Cisco Unified Communications Manager, which tool do you use to check SIP traces?

A. MTP
B. CCSIP
C. RTMT
D. OS Administration Page

Answer: C

NEW QUESTION 23
If all patterns below are configured in Cisco Unified Communications Manager which would be used when dialing the pattern “123”?

A. 12!
B. 12X (urgent priority set)
C. 1XX (urgent Priority Set)
D. 12[2-5]

Answer: B

NEW QUESTION 24
Which configuration must an administrator perform to display Translation Pattern operations in Cisco Unified Communications Manager SDL traces?

A. Enable the Detailed Call Analysis option under Enterprise Parameters for Unified CM.
B. Set up the Digit Analysis Complexity in Service Parameters for Cisco Unified CM to TranslationAndAlternatePatternAnalysis.
C. Check the Translation Patterns Analysis check box in Micro Traces on the Cisco Unified CM Serviceability page.
D. By default, the Translation Patterns operations are printed in SDL traces, so no additional configuration is necessary.

Answer: A

NEW QUESTION 25

Refer to the exhibit. Users report that when they dial the emergency number 9911 from any internal phone, it takes a long time to connect with the emergency
operator. Which action resolves this issue?

A. Adjust the service parameter T302 timet to the desired value.
B. Adjust the service parameter T204 timer to the desired value.
C. Check the Urgent Priority check box under 9.911 pattern.
D. Point the emergency pattern directly to the PSTN gateway.

Answer: C

NEW QUESTION 26
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Refer to the exhibit. An administrator is troubleshooting a situation where a call placed from a phone registered to Cisco Unified Communications Manager does
not complete. The administrator wants to use the Dialed Number Analyzer on Cisco Unified CM to check which translation pattern the call is matching. However,
when logging in to Cisco Unified Serviceability there is no option for Dialed Number Analyzer under the tool menu. Which two steps must be performed to resolve
this issue? (Choose two.)

A. Restart the subscriber
B. Activate the Cisco Extended Functions service.
C. Activate the Cisco CallManager service.
D. Activate the Cisco Dialed Number Analyzer service.
E. Activate the Cisco Dialed Number Analyzer Server service.

Answer: DE

NEW QUESTION 29
How does an engineer globalize routing for ingress calls coming from the PSTN to internal DNs?

A. At the PSTN gateway, put the calling number in PSTN format and the called number in DN format.
B. At Cisco Unified CM, put the calling number in E.164 format and the called number in PSTN format.
C. At the PSTN gateway, put the calling number in E.164 format and the called number in localized (DN) format.
D. At Cisco Unified Communications Manager, put the calling number in E.164 format and the called number in E.164 format.

Answer: B

NEW QUESTION 31
When configuring hunt groups, where do you add the individual directory numbers that will be part of the group?

A. route group
B. line group
C. hunt list
D. hunt pilot

Answer: B

NEW QUESTION 36
Which two configuration parameters are prerequisites to set Native Call Queuing on Cisco Unified Communications Manager? (Choose two.)

A. Cisco IP Voice Media Streaming Service must be activated on at least one node in the cluster.
B. A unicast music on hold audio source must be configured.
C. Cisco RIS data collector service must be running on the same server as the Cisco CallManager service.
D. The maximum number of callers allowed in queue must be 10.
E. The phone button template must have the Queue Status Softkey configured.

Answer: AC

NEW QUESTION 41
What is the relationship between partition, time schedule, and time period in Time-of-Day routing in Cisco Unified Communications Manager?

A. A partition can have multiple time schedules assigne
B. A time schedule contains one or more time periods.
C. A partition can have one time schedule assigne
D. A time schedule contains one or more time periods.
E. A partition can have multiple time schedules assigne
F. A time schedule contains only one time period.
G. A partition can have one time schedule assigne
H. A time schedule contains only one time period.

Answer: A

NEW QUESTION 46
A user reports that when they attempt to log out from the Cisco Extension Mobility service by pressing the Services button, they cannot log out. What is the most
likely cause of this issue?

A. The Cisco Extension Mobility service has not been configured on the phone.
B. There might be a significant delay between the button being pressed and the Cisco Extension Mobility service recognizing i
C. It would be best to check network latency.
D. The user device profile has not been assigned to the user.
E. The user device profile is not subscribed to the Cisco Extension Mobility service.

Answer: D

NEW QUESTION 47
What is a component of Cisco Unified Mobility?

A. Unified IVR
B. Mobile Connect
C. Smart Client Support
D. Single Number Connect
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Answer: B

NEW QUESTION 49
Which services are needed to successfully implement Cisco Extension Mobility in a standalone Cisco Unified Communications Manager server?

A. Cisco Extended Functions, Cisco Extension Mobility, and Cisco AXL Web Service
B. Cisco CallManager, Cisco TFTP, and Cisco CallManager SNMP Service
C. Cisco CallManager, Cisco TFTP, and Cisco Extension Mobility
D. Cisco TAPS Service, Cisco TFTP, and Cisco Extension Mobility

Answer: C

NEW QUESTION 53
......
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